TABLE OF CONTENTS

Rationale & Mission ................................................................. Section 1
Overview of Graduate Program of Study ................................ Section 2
Admission Requirements ......................................................... Page
Continuation .............................................................................. Section 3
Completion ............................................................................... Section 4
Rationale & Mission

Conceptual Framework

Programs of Graduate Study in the Teacher Education Department at Adams State College are based on a model of teacher as reflective decision-maker who demonstrates leadership, is a competent professional, and facilitates learning for all students. Each of these three competencies is described in the Conceptual Framework for the School of Education and Graduate Studies (http://teachered.adams.edu). Characterizing teachers as reflective decision-makers includes the ability to:

- think about classroom processes and how they affect students;
- select and organize content;
- employ and vary the use of technological applications;
- utilize a wide range of instructional methodologies and strategies;
- manage classrooms;
- utilize appropriate teaching activities and materials; and,
- positively promote the diverse social, emotional, physical and intellectual needs of students.

Degrees Offered

Adams State College offers a single Masters in Education degree that allows candidates the flexibility to choose from among several emphases, including emphases that lead to a state teaching endorsement (marked with an asterisk '*'). The emphases currently approved are:

- Language, Literacy & Culture:
  - Teacher of Linguistically Different*
  - Reading Teacher (Literacy)*
- Special Education - Moderate Needs*
- Educational Leadership*
- Curriculum
- Language, Literacy & Culture / Special Education - Moderate Needs* (combination)
- Technology

These emphases reflect the identified needs of districts and teachers, and are designed to assist schools in meeting the needs of all students.
A Masters Plus program is also available for candidates from other major disciplines who would like to complete an advanced degree as well as obtain a secondary teaching license. Individuals interested in the Masters Plus program of study should speak with the Chair of the Teacher Education Department regarding program requirements and options.
Section 2

Overview of Program

Admission

The requirements for admission are also described in the Graduate Catalog.

Applicants may be fully admitted with the following academic prerequisites (previous graduate level coursework will be considered):

- GPA of 3.0 or higher in prior 60 hours of college coursework; or
- GPA of 2.75 – 2.99 with GRE of at least 1250 or MAT of at least 47

The first step in applying for Graduate study at ASC is to request an application from the Graduate Programs Office. After all application procedures have been completed, applications are forwarded to the Teacher Education Department for consideration.

Please note that ASC graduate education programs assume prior teaching licensure, and that Special Education, Teacher of Linguistically Different, and Reading Teacher endorsements can only be granted after initial licensure has been completed. In contrast, the MA+ program combines initial licensure and master's degree requirements.

The Graduate Programs Office will respond to applicants in writing.

Advising, Degree Plans, and Course Transfers: Upon acceptance into the program, candidates will be assigned an academic advisor. This person will be the Graduate Office advisor if the candidate is applying on his or her own; if admitted into a grant-funded program of study, the advisor will be the corresponding project director for the grant.

The graduate programs advisor is the contact regarding the following for non-grant candidates:

- Program information (e.g., course content; graduation requirements)
- Degree plans
- Advising

The respective grant director is the contact regarding the following for grant-funded candidates:

- Program information, including additional requirements for participation in the grant
- Degree plans
- Advising

The Teacher Education Department Chair will sign all degree plans.
It is the responsibility of the candidate to meet regularly with the assigned advisor regarding any questions about the program of study. Each candidate’s program of study will be developed as follows:

- Within the first six hours of graduate study each candidate, working with the advisor, will completed and sign a degree plan. **Students who fail to comply will not be allowed to register for further graduate study.** The candidate, the advisor, and the ASC Graduate Programs Office will retain copies of the degree plan.

- Students in off-campus cohorts will complete and sign their degree plan within the first six hours of study as a group.

- Once signed, the degree plan constitutes a formal contract between the student and ASC. No changes or substitutions may be made in the degree plan without the written approval of the Chair of the Teacher Education Department at ASC.

- 9 hours of approved courses may be transferred into a degree plan (see below). **Copies of syllabi and transcripts must be included in order for the request to be considered.** Phone calls will not suffice. Students who intend to substitute courses taken elsewhere must obtain the approval of the advisor and Chair of TED at the initial stages of advising. ASC is not obligated to accept any specific course for credit.

**Course Transfers into Cohort Graduate Programs of Study:** As a matter of policy, it is recommended that requests for transfer of courses in place of cognate course requirements be denied. The rationale for this position is that (1) a critical characteristic of a cohort is that a finite group of students move through their program of study as a cooperative learning unit and (2) material in cognate course requirements is designed to facilitate the successful undertaking of the PLACE Test. Requests for transfer credit of core (PSYCH 503, ED 549 & 550) requirements will be forwarded to the appropriate faculty committee for consideration.

**Conditions of Programs:** Because many on-campus courses are offered in most sessions, students (with approval of advisors), generally have some flexibility in scheduling classes and field experiences. Off-campus programs are designed for delivery to intact cohort groups and follow a specified cycle of delivery. Please note the special conditions for off-campus delivery:

**Missed Courses in a Sequence:** A student who, for any reason, misses a course in the delivery sequence, must arrange to take the course at a later date. ASC cannot commit to offering a course for any single student. Students who miss courses in a cycle may:

- Come to the ASC campus in Alamosa and take the course missed;
- Wait for the next local offering and take the course then (though ASC makes no guarantee that additional courses will be offered at any given site);
- Take an equivalent course at another institution or approved ASC site. **Prior approval of the advisor and Chair of TED must be granted.**

Please note that independent study courses are generally not approved for either on- or off-campus graduate study, and that workshop or in-service credits usually do not fulfill graduate degree requirements.

**Course Transfer Forms:** A course transfer form, signed by the advisor and Chair of TED, must be completed and filed at the time a course transfer is made. Timelines are important; students must not wait until graduation to complete and file these forms.

**Degree Plans:** All graduate students, whether on-campus or off, are expected to have completed, signed, and filed a degree plan within the first 6 hours of graduate study. **All**
previous graduate coursework intended for transfer must be submitted to the faculty advisor and to the Chair, TED and noted on the original degree plan in order to be considered for graduate credit.

Students seeking a general Master’s Degree (not in a concentration specified above) will no longer find differentiation between elementary and secondary programs. Instead, ASC offers a single degree to all students. Degree plans for all emphases listed above are available on-line at: http://teachered.adams.edu, or from the Graduate Office, 800/662-3382.

**NOTE:** Applicants for graduate study through grant-funded programs are responsible for obtaining and understanding any additional requirements that may be imposed by the grant. Questions about these requirements should be addressed to the grant director of the program in which the student is participating.

### Assessment Continuum

The following table outlines the evaluation measures required of all students at each of the four stages of graduate study, for each of the three components of a reflective decision-maker: Leadership, Professional Competence, and Facilitator of Learning. For each of these measures you will provide feedback or evidence (bulleted items) that will be used to assess both your progress and program effectiveness.

<table>
<thead>
<tr>
<th>Benchmarks</th>
<th>LEADER</th>
<th>“Reflective Decision-maker”</th>
<th>FACILITATOR OF LEARNING</th>
</tr>
</thead>
</table>
| Admission  | • Letters of Recommendation  
            • Prior Experience       | • Letters of Recommendation  
            • License & Endorsements  
            • MA/GRE scores           
            • Prior degree           | • Letters of Recommendation |
| Continuation| • Portfolio  
                • Coursework  
                • Classroom practice | • Ongoing GPA  
                • Coursework  
                • Classroom practice | • Coursework  
                • Classroom practice |
| Completion | • Portfolio  
                • Culminating Academic Review  
                • Internship | • Final GPA  
                • Culminating Academic Review  
                • PLACE Exam  
                • Internship  
                • Portfolio | • Internship  
                • Culminating Academic Review  
                • Portfolio |
| Post-Graduate| • Survey | • Survey | • Survey |

Each program emphasis (e.g., Special Education) will have slightly different expectations for candidates. These differences reflect the knowledge and skills required of graduates as outlined in the state and national standards for the area of emphasis. Candidates will be made aware of assessment expectations at the outset of their program of study. Questions or concerns should be directed to the graduate program advisor.
Graduate Study and Professional Licensure

Teacher education graduate study may involve both professional licensure and academic degree components. It is important candidates understand the distinction between the two:

**Professional licensure:** All masters programs in education at Adams State College require that the applicant possess a valid teaching license. Prior to completing their program of study (generally during the last semester), candidates are required to take the relevant PLACE endorsement test for their emphasis area (Reading Teacher, Teacher of Linguistically Different, Special Education-Moderate Needs, or Educational Leadership).

After successful completion of coursework and receipt of a passing grade on the corresponding PLACE exam, Adams State College will recommend the candidate to the Colorado Department of Education as having completed the program of study leading to the endorsement. The ultimate decision to grant an endorsement rests with the state department of education.

**Academic Degree:** Upon successful completion of the academic program of study, which includes passing evaluations of the CAR and academic portfolio, the School of Education and Graduate Studies will recommend the student for a Master of Arts in Education.

In the event that the candidate does not pass the CAR, a remediation plan will be developed by teacher education faculty in order to assist the candidate in successfully completing his or her academic program of study.

NOTE: Candidates may still graduate and receive their degree even if they fail to pass the PLACE test. Likewise, candidates may pass the PLACE test and receive an endorsement to their teaching license but fail to receive their MA. Requirements for the endorsement and degree are different!

**Student Standing:** All students admitted to Adams State College are expected to abide by the obligations described in the General Catalog. This includes remaining a student in "good standing." Throughout their programs of study candidates are required to understand and comply with professional and ethical standards of conduct. Failure to comply with these standards of conduct will result in a faculty review of a student’s standing and whether the candidate should be permitted to continue.

Academic Portfolio

**What Is It?**

The program of graduate study is designed to provide you with both practical and theoretical experiences in your area of emphasis. These experiences are intended to be cumulative. As evidence that your program is attaining the stated goals and objectives you will be compiling a portfolio that will serve as a professional resource for you both during and after your formal program of study.

This portfolio will eventually contain, at a minimum, the following five components:

1. Identifying information about the candidate (e.g., vitae; outline of teaching context)
2. Coursework artifacts and reflections
3. Research project proposal, data, results (as applicable)
4. Required components for the Culminating Academic Review (CAR)
5. Professional Resources (e.g., articles, www sites, materials)

The evaluation of this portfolio will be outlined below.

**Coursework**

All Masters programs share a "core" of three classes, which all candidates are required to take. Candidates admitted to the Graduate School as "conditional" (see p. 3) will be required to show successful completion of their initial 6 hours of coursework. The core classes are:

- **PSYCH 503**
  - Introduction to Research
- **ED 549**
  - Educating Diverse Learners
- **ED 550**
  - Curriculum and Assessment

**Style & Format Requirements**

As a matter of policy, the faculty of the Department of Teacher Education unanimously approves the use of the most current edition of the *Publication Manual of the American Psychological Association* (APA) for use by candidates in all formal written assignments in the graduate program of study.

**Degree Plan**

All candidates are required to have a signed degree plan filed in the Graduate Office by the end of six (6) hours of graduate coursework. Both the student and advisor should sign this plan.

**Candidates for Endorsement Only**

Candidates who already have a masters degree and are only pursuing a teaching endorsement will have a modified program of study. While they will still have a signed plan of study, they will generally be exempt from:

- The "core" coursework (PSYCH 503, ED 549 & 550); and,
- the Culminating Academic Review.
However, all candidates for endorsement only must still pass the appropriate PLACE exam as condition of participation in graduate programs. Detailed expectations for each endorsement only candidate will be agreed upon with the advisor at the beginning of the candidate’s program of study.

## Grades & Program Standing

### Grades

A 3.0 (out of 4.0) GPA is required for graduation. Candidates may receive a “C” in one class but still have an overall GPA of 3.0 or higher. However, candidates who receive a “C” may be required to repeat the class. Candidates receiving a “D” or “F” in a course will have their program standing reviewed by TED faculty.

### Grade Appeals

Concerns regarding course grades should first be brought to the course instructor. If a satisfactory agreement is not reached, the candidate may appeal in writing to the Department Chair. If that does not resolve the issue to the satisfaction of the candidate, the Chair will inform the candidate about taking an appeal to the next level.

### Academic Dismissal

If a student fails to meet the academic requirements of the program, he or she may be dismissed or asked to withdraw from the program. This decision will be made by three faculty members of TED, who will also stipulate the conditions, if any, for readmission.

The candidate may appeal the decision of the committee by writing to the head of the committee. If a satisfactory agreement is not reached, the candidate may appeal in writing to the Teacher Education Department Chair. If that does not resolve the issue to the satisfaction of the candidate, the Chair will inform the candidate about taking an appeal to the next level.

### Non-Academic Dismissal

A candidate may be dismissed from the program for non-academic reasons, such as unethical conduct, unprofessional behavior, an inability to successfully meet the demands of a graduate program of study, or other reasons that may be documented by the Teacher Education Department.

When a concern about a candidate arises, a committee of three TES faculty will meet to consider the circumstances and evidence. The candidate will be notified in writing and given an opportunity to respond to faculty face-to-face. The decision of the committee may be appealed by writing to the head of the committee. If a satisfactory agreement is not reached, the candidate may appeal in writing to the Department Chair. If that does not resolve the issue to the satisfaction of the candidate, the Chair will inform the candidate about taking an appeal to the next level.
Continuation

Coursework

Coursework in this stage of your program involves the “cognate” or courses directly related to your area of emphasis. The degree plan signed during the Admission stage should specify the courses to be taken and when. As this coursework varies from program to program, only those requirements common to all degree programs will be outlined here. Any questions regarding a specific program of study should be addressed to the graduate program advisor.

Practitioner Research Project

Together with their advisor and course instructor(s), master’s degree candidates will design and carry out a research project, or develop an action research plan, as part of their program of study. This project will provide candidates with the opportunity to explore a topic of interest, usually in the candidate’s own classroom or school, within the context of formal research methodology. Students will define a problem, conduct a literature review, carry out a study, report on findings utilizing suitable techniques, discuss the findings and implications, and include the results in their academic portfolio. Because of the nature of this project, students will submit a proposal and receive project approval from their ASC advisor before commencing. Depending on the program of study, candidates will carry out their projects by

- completing the Intro to Research course (3 credits) where a tentative question for study will be generated;
- successfully progressing through initial cognate coursework where the question will be refined and the project design outlined;
- completing a Practitioner Research course (3 credits) where data can be collected; and,
- producing a final project write-up by the end of the internship.

A summary of the findings will comprise part of the “Culminating Academic Review” (CAR) which each candidate will be required to pass before graduating.
Academic Portfolio

As mentioned above, each candidate will develop a portfolio that reflects the individual's experiences during the program of study. This document may vary slightly from one emphasis to another, but at a minimum it will contain:

1. Identifying information about the candidate (e.g., vitae; outline of teaching context)
2. Coursework artifacts and reflections
3. Research project proposal, data, results (as applicable)
4. Required components for the Culminating Academic Review (CAR)
5. Professional Resources (e.g., articles, www sites, materials)

A rubric for evaluating the portfolio follows:

---

**Rubric for Evaluation of the Evidence Folder**

**Adams State College**

**Mechanics of the Folder**

1. **Organization**

   - Exemplary _____
   - Proficient _____
   - Developing _____
   - Needs Improvement _____

   **Exemplary:** The portfolio shows strong, logical organization. It is easy to find materials in the portfolio and the sequence of material is easy to follow.

   **Proficient:** Organization of material makes it easy to navigate within the document. Material is clearly labeled and the order is easy to understand.

   **Developing:** Shows weakness in organization. It is easy to get lost and hard to understand why some sections and materials appear where they do.

   **Needs Improvement:** Organization is difficult to follow and the user is not given enough direction on how to use the portfolio. Sections are not clearly labeled.

   **Comments:**

   2. **Visual Design**
**Exemplary:** A visual treat. Very interesting use of design and color that makes the portfolio welcome the reader. Uses pictures effectively.

**Proficient:** Format of portfolio shows balance and is appealing. Appropriate colors are used throughout the portfolio. Text is clean and easy to ready.

**Developing:** Shows some balance and harmony. Few pictures. Colors and graphics need improvement.

**Needs Improvement:** Shows little understanding of visual principles. Colors and backgrounds are used in an inappropriate matter. No or poor use of graphics. Overall design of the portfolio including the cover is not appealing. No pictures.

**Comments:**

### 3. Grammatical Accuracy/Writing Style

**Exemplary:** No spelling, punctuation or grammar errors in any of the paperwork in the portfolio. Sentences are well constructed. Writing style in the portfolio is clearly at a graduate level.

**Proficient:** Contains no spelling errors. Grammar is correct throughout the portfolio. Correct punctuation is used. Writing style to be at a graduate level is in need of improvement in some areas.

**Developing:** Contains some spelling errors or grammar mistakes. Written material lacks proper punctuation at times. Writing style is clearly in need of improvement.

**Needs Improvement:** Contains spelling errors or grammatically incorrect sentences. Written material lacks punctuation or is not punctuated. Writing style is not at a graduate level.

**Comments:**

---

### Program Objectives

#### 1. Content Aspects

**Exemplary:** The portfolio artifacts and reflections clearly address the proficiencies and the vision and mission statement of the Adams State College Teacher Education Department. Reflection is used throughout the portfolio in an effective manner. The portfolio represents an individual ready to assume administrative responsibilities.

**Proficient:** Artifacts address the proficiencies and the vision and mission statement of the Adams State College Teacher Education Department. The candidate could show a deeper understanding of the proficiencies and the vision and mission statement. The candidate could make better use of reflection.
**Developing:** Indicates a general understanding of the proficiencies and show some commitment to the vision and mission statement of the Adams State College Teacher Education Department. Materials could show a deeper understanding of the proficiencies and make better use of reflection.

**Needs Improvement:** Does not address the six proficiencies or show a commitment to the vision and mission statement of the Adams State College Teacher Education Department. No reflection indicated.

Reviewer: Please comment on the level of competency for each proficiency. Each proficiency should also contain a reflection piece on the major elements of the Adams State College Teacher Education Department Vision and Mission Statement: Reflective Decision Maker, Educational Leader and Learning for All Students.

**Proficiencies:**

1. Commitment to Safe and Quality Learning:

2. Commitment to Ethical and Moral Standards

3. Commitment to Equal Opportunity for All Students

4. Commitment to Professional Development

5. Commitment to Quality Supervision

6. Commitment to the Use of Technology for Education Improvement
Completion

Coursework/Internship

Masters emphases that also lead to state teaching endorsements include at the Completion stage of their programs of study an internship teaching experience. This experience is usually conducted in the candidate's own classroom and school, unless the classroom context is not appropriate (e.g., the candidate for Language, Literacy & Culture has no linguistically different students in her class). Such cases should be anticipated and alternative teaching arrangements made with the graduate advisor before the beginning of the internship.

Both the number of hours required for completing the internship and the internship itself is a state requirement and cannot be waived. Candidates pursuing the endorsement only must still conduct an internship. Your advisor will apprise you of the number of hours required and help you find the best way to fulfill this requirement.

PLACE Exam

Candidates who are taking the program of study for state endorsement to their license must take and pass the appropriate PLACE test. Generally this is done during the last semester of study before graduation.

Culminating Academic Review (CAR)

All aspects of graduate education should allow candidates an opportunity to demonstrate their professional competencies. Therefore, a culminating experience provides program faculty a performance assessment of a candidate's ability to respond to situations and issues relevant to the program of study.

This experience will typically last from 30-45 minutes, and consist of:

1. A 15-20 minute candidate presentation that summarizes the program of study and provides evidence that the candidate has
   a. gained an understanding of key concepts and theories in the field, and
   b. is able apply those concepts and theories to classroom practice

2. 10-15 minutes for the panel to respond to the presentation and ask questions of the candidate
An Examining Board will evaluate the candidate’s performance during the culminating experience. Rubrics (click here for example) will be used to evaluate all three sections of the culminating experience. The Examining Board shall consist of some combination of the following individuals:

- ASC School of Education and Graduate Studies Faculty from relevant area of emphasis (Ed. Leadership, Special Ed., Language, Literacy & Culture, etc.)
- Practicing administrators or teachers
- Professors outside the area of emphasis

After the CAR, the candidate and the candidate’s advisor will be provided with the Examining Board’s scores. The candidate and advisor will also be provided with a summary of the evaluators’ comments of the candidate’s performance citing both strengths and areas needing improvement.

If the candidate’s performance on any section of the culminating academic review is considered “below proficient”, the candidate’s advisor will develop a prescription plan together with the candidate in order to remedy the identified weaknesses. The candidate must then satisfy the advisor before a passing evaluation of the culminating academic review is awarded.

Candidates must receive a rating of “proficient” or above in all three areas in order to graduate!
Completion

Diploma

A diploma will be mailed to you approximately 6-8 weeks after graduation. This allows the college to review transcripts and coursework, and assign the appropriate degree. A letter certifying completion of the degree can be obtained from the Graduate Office if needed sooner.

Survey

Graduation is not the end of your relationship with Adams State! We remain interested in supporting graduates after the completion of their formal program of study. Sometime after graduation you will receive a survey. We encourage you to take the time to respond. Your responses and comments will help us make program improvements that will benefit future candidates.

PLACE Exam

Where applicable, candidates who have not taken and passed the appropriate PLACE exam before graduation are expected to do so as soon as possible afterwards. This is a requirement of the program of graduate study. Candidates for a state endorsement to their license must take and pass the appropriate PLACE exam before the endorsement will be granted. This is a state requirement and cannot be waived. Remember, failing to pass the PLACE test does not affect whether you receive the academic degree.

Examples of prior year’s exams are available from the Colorado Department of Education. In addition, candidates and faculty often arrange study groups prior to exam dates. The current year’s registration and exam dates may be obtained by contacting the Graduate Office, or going to www.place.nesinc.com.
More Template Tips

There are three ways to view the various style names of template text:

1) In Normal view, choose Tools Options. Click the View tab. In the Style Area Width box, dial up a number such as “1” and click OK. Observe the style name next to each paragraph; or

2) In Page Layout view, click on any paragraph. View the style name on the Formatting toolbar; or

3) From the Format menu choose Style Gallery. In the Preview section click on Example or Style Samples.

How to Create a Table

Choose Insert from the Table menu. Be sure to choose the Professional AutoFormat if you are using a Professional style template.

To modify an existing table, such as the table below, position your cursor in any cell. To modify the table, access the Table menu to select the desired action and/or result.

<table>
<thead>
<tr>
<th>Competitor Ranking</th>
<th>Current Share</th>
<th>Share in 3 Yrs.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Largest competitor</td>
<td>50%</td>
<td>30%</td>
</tr>
<tr>
<td>Second largest competitor</td>
<td>25%</td>
<td>20%</td>
</tr>
<tr>
<td>Third largest competitor</td>
<td>15%</td>
<td>12%</td>
</tr>
</tbody>
</table>

• Table. Projected growth of competitors over 3 years.

How to Edit Table Text

You can edit and format table text like regular text. Simply select text and type to replace, and use the Format menu to change the font and/or paragraph attributes.

How to Change a Header or Footer

In Page Layout view, choose Header or Footer from the View menu. Once activated, you can change or delete the text just like regular text. When done, click Close to exit.

To delete a ruling line in the Header or Footer, from the Format menu choose Borders and Shading. Choose None from the Preset section, and click OK.